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  Editorial


  The big news this month is the announcement from Dell that they will ship both desktop and laptop machines with Ubuntu pre-installed. You may say "It's only one company," but correct me if I am wrong, (and I'm sure you will), but Microsoft began their rise to dominance from just one deal with IBM. And if Microsoft can do it, we can do it... and better!

  

  I also want to take this opportunity to thank everyone in the Ubuntu community who helped make the full circle pilot issue such a roaring success! I wish I could name you all one by one but it'd take up the entire issue! Within one week we had over 25,000 downloads! As I write this editorial we are heading for the 55,000 mark. Within days of releasing issue #0 we had a flood of emails from volunteers wanting to translate full circle. As I write this we have six translations for download now with several more on the way. If you would like to translate this magazine into your native language please visit our wiki translation page, read the guidelines, and get to it!

  

  If family history is your thing then we have a special treat for you with a review of GRAMPS - the Linux genealogy software - next month we hope to have an exclusive interview with its creator.

  

  Maybe you're more of the DIY type? In our How-To's this month we have the in's and out's of those directories are on your hard drive, the first in my series of Scribus tutorials, an introduction to MythTV and lots of other good stuff.

  

  I hope you enjoy this first issue and remember; myself and the team are all on our website forum at www.fullcirclemagazine.org and also on irc, channel #fullcirclemagazine on the irc.freenode.org server. Come say hello!

  

  All the best,

  

  Ronnie


  

  



  News


  Dell partners with Ubuntu!


  With many people speculating on whether Dell would ship a distro of Linux pre-installed on its laptops, it came as something of a surprise to see that Dell CEO Michael Dell uses Ubuntu 7.04 on his home laptop!

  

  Within days the worlds worst kept secret was out; Dell announced that it would indeed begin shipping some of its laptop and desktop machines with Ubuntu 7.04 : Feisty Fawn.

  

  This was sparked by Dell asking its customers what they would like to see in future Dell machines. Much to Dell's surprise, many of its users asked for Linux to be preinstalled!

  

  All respect to Dell for listening to its customers, following through on their promise to give the customer what they want and taking the bold move of using Linux. Bravo!

  

  Sunnz - sunnzy@gmail.com

  


  Linux: Violating Microsoft Patents?


  Brad Smith, Microsoft's top lawyer, has stated that open source software violates 235 of the software giant's patents including 42 in the Linux kernel, 65 in the Linux interface and related design elements, and 46 in OpenOffice.org.

  

  "What's fair is fair. We live in a world where we honor, and support the honoring of, intellectual property. [Open source needs to] play by the same rules as the rest of the business," said Microsoft CEO Steve Ballmer. Prosecuting the violations could prove problematic for Microsoft as several major supporters of open source hold a number of patents which could possibly be used to attack Microsoft's own software including Windows.

  


  Ubuntu goes mobile


  The BBC News website reports that :

  

  A version of the increasingly popular Linux operating system Ubuntu will be developed for use on net-enabled phones and devices.

  

  The Ubuntu Mobile and Embedded project aims to create the open source platform for initial release in October 2007.

  

  The operating system will be developed by members of the Ubuntu community, along with staff from chip giant Intel.

  

  Source - http://news.bbc.co.uk/1/hi/technology/6634195.stm

  


  Ubuntu Tribe - The Movie


  From the Press Release :*Ubuntu Tribe is a semi documentary cyberomantic comedy, filmed under the Dogme95 rules. The short movie, still in development, will be distributed on-line under the Creative Commons license.

  

  The original version will be in Euskara with two subtitled versions; one in English and one in Spanish.

  

  The project is still in development. And you can be active part of it. If you have an idea or wish to offer your point of view please let us know at info@ubuntutribe.com.

  

  You can find out more, and view the trailer at the official page: ubuntutribe.com

  


  OLPC OS Up For Download


  If you've never heard of OLPC maybe the words One Laptop Per Child will ring a bell in your head, as this project has been covered by many news reports world wide, be they IT inclined or just your seven o'clock news. OLPC is a US non-profit organization created by MIT Media Lab Faculty members aimed at developing a cheap and easy to use computer for the children of the third-world. The operating system - or XO as it is called - is based on open-source software and it's applications will consist of a web browser, based on Mozilla Firefox's Gecko engine, a document editor - AbiWord, a RSS reader, an email client, music composition and graphics toolkits, games and even a shell for those who feel the need for a bit more freedom . Probably the most innovating thing about the OS is the ease of use and intuitive interface. You can see some screenshots here.

  

  The operating system, based on Fedora Core, can now be downloaded and burned on a disc which runs as a Live CD on a standard Mac or PC. This is a great opportunity for people who like to experiment with strange flavors of Linux, but also for those who either don't have the time nor will, to understand how to operate in your typical desktop environment. XO brings a ready to use system where commands like ./configure or sudo make install will be things the “grandpa” user - who doesn't use the computer for more than browsing the web and reading his emails - won't have to deal with. There are of course some negative aspects to the operating system... such as the lack of audio/video handlers, the lack of PDF support, and probably the worst: the heavily modified and over simplified AbiWord saves the files in the .doc format by default. It's a pity that this closed-source format is being used and without explaining to the user what the difference between doc and odt are, even if most people have MS Word installed and cannot open most FOSS documents.

  

  Despite any shortcomings, this project has true potential. But I have to say that from looking at those screenshots it looks promising. I don't know how many people will use it for PC for other purposes than experimenting, but this could prove to be a real alternative to the constantly busy desktop environments – such as KDE or Gnome, for instance. If you do decide to download the disc and give it a try, you may want to go and make a cup of tea, as it takes a long time for the page to load.


  


  



  Open Week Highlights


  23rd - 28th April 2007

  

  Filled with several hundred Ubuntu users, chatroom #ubuntu-classroom had Canonical employees - and community volunteers - explain what they do, how they do it and, most importantly, answer users questions. One Canonical employee taking questions was one Mark Shuttleworth (aka: SABDFL - Self-Appointed Benevolent Dictator for Life). What follows are a few snippets of his two Q&A sessions.

  

  Mark, will there exist in the future a certification relased by Canonical, like RedHat Certified Professional?

  

  yes! along with training programs, and training materials

  

  ShipIt is currently not available for Xubuntu... will that become available in the future?

  

  i don't think so. xubuntu, as i understand it, is a more specialist environment, so we probably would not fund cd shipments for it.

  

  I've seen some of the estimated numbers for *buntu, but I'm curious... how many unique IP addresses did the canonical servers see on th 19th of April?



  wow, not sure i have that number, but there were 53 mirrors before we announced, and 130 by the end of the day, that we know of. so hits on canonical.com are a small fraction of total. i think we were serving 12 gigabits / second from ourselves and top 5 mirrors :-). probably 20 gbits/s in total. 3 cd's per second for 12 hours. pretty amazing. if you were in #ubuntu-release-party, you know it was quite a rush

  

  Any rough numbers on how many *buntu machines there are running in the world currently?

  

  4-16 million, my best guess including derivatives is around 10 million

  

  Several ubuntu pages and also bug #1 in launchpad note that ubuntu is entirely free (as in free speech), however in the default install this is not true (drivers etc.), are there plans on making this more transparant to the user?

  

  we should always qualify that as "only free applications". at least, i fix it that way in the wiki when i run into it. we have had the driver exception in place since the beginning, so it's not as though this has changed. hopefully, the new flavour will also carry the "pure free" flag

  

  full circle was even mentioned, twice!

  

  is full circle magazine also a marketing team project?

  

  Jenda replied - it's been communicating with the Marketing Team, and it's very much supported. But it has never explicitly declared itself as such to my knowledge. some members from the Marketing Team participate in it, but it was started (and is run by) from someone outside the team

  

  What can you say about the Full Circle magazine, Ubuntu community magazine released issue #0. Perspectives for the future?

  

  Jono replied - I had a look at it and I think its interesting - I have been looking to get in touch with the authors about a few things - so if they can get in touch with me that would be great. I think an ubuntu magazine is a pretty nifty idea, although a lot of these kinds of magazines due due to production time. I hope this continues



  [Editors note: i've since emailed Jono]

  



  Flavor Of The Month

  Ubuntu 7.04 - Feisty Fawn


  Written by Robert Clipsham


  If you have decided to switch to Linux, and have decided you want to try Ubuntu, but don't know how, this is the guide for you.


  For Kubuntu, see next month.


  Before you start...


  Checklist


  If you are using another operating system e.g. Windows XP, make sure you have defragmented your hard drive (In windows, go to start, then run, and type defrag)


  Make sure your PC is set to boot from the CD drive - See below


  Make sure you have burned your Live/Desktop CD properly


  Make sure your PC meets the minimum system requirements: If you are running Windows XP, then your PC is more than fast enough.


  Once you have downloaded and burned the Live/Desktop CD, restart your PC, with the disk in your CD/DVD drive. If you don't see this screen:
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  But instead see your usual windows loading screen, you need to change some options in your BIOS. If at this point, you are hesitant to make the switch, don't be, there's nothing to worry about.


  BIOS stands for Basic Input Output System. It is a small chip in your PC, that makes basic decisions, like which order to boot your PC. On most PCs It is set to Floppy Drive, Hard Drive, CD-ROM Drive. Most PCs now, don't have floppy drives, so the boot order is the same without 'Floppy Drive'. If you have an additional CD/DVD drive this may also be on the list. The Reason you don't see the screen above, is that it is checking your Hard Drive for an operating system first. When it sees windows, it boots that, and aborts searching for any other bootable devices.


  To change your boot order, you need to know how to get into your BIOS Settings. This is usually achieved by hitting (not literally) F1, F2, Esc, Del or F10. When you turn your PC on you will see a message saying press to enter setup. If it goes to fast, press the Pause/Break key when it is displayed. Restart your PC when you know what it is and hit that key. Note: If you still don't know how to get into the BIOS contact your manufacturer, or search for 'Enter BIOS' on google for some excellent guides. Note: You can't use your mouse in the BIOS!!! In the BIOS you need to look for an option called 'Boot configuration' or similar. To navigate around the BIOS, use your arrow keys and enter to select. To go back, hit Esc. The options you need to change will be something like:


  Boot Device 1: Floppy

  Boot Device 2: HDD

  Boot Device 3: CD ROM


  Use the arrows to select HDD (Abbreviation for Hard drive) hit enter and select CD. Make sure Boot device 3 has been changed to HDD. When you are done, hit Esc, to get back to the main menu, then read the top/bottom of the screen and look for what to press to 'Save Configuration and Exit'. WARNING: If you think you have changed any options that are not relevant to this, use Esc to exit without changing, and start again.


  WARNING : Do Not change any options, that you think would be worth changing. You can make your PC unusable.


  You should now be able to see the above screen when you turn on your PC. First of all, (using the arrows again) 'Check CD for defects'. This will check for any problems on the CD, to make sure you have no problems. If it gives an error, you will need to re-burn your disk, possibly at a slower speed. It should then restart your PC, and bring up the same screen again.


  This time select 'Start or install Ubuntu'.


  After a quick loading bar and some text, you should see a nice Ubuntu logo, and this loading bar:


  This loading bar will be your friend for the next few minutes.


  You now have two options, sit and stare, enchanted by the gentle rocking, or get a cup of tea and a biscuit: It's not going anywhere for a while.
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  Once it finally decides to load (hopefully it won't take long) you will be presented with the default Ubuntu desktop, a lovely shade of brown. I didn't want to waste a screenshot, so here it is:
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  You may now think 'Well that was easy! I don't know what all the fuss is about'. I should probably point out now, that your install CD doubles as a live CD. A live CD lets you run the operating system from the CD, rather than installing it. If you click the menu options, you can choose from a selection of programs including:


  Firefox – Award winning internet browser

  OpenOffice – Full Office suite – backwards compatible with Microsoft Office

  The GIMP – Image editor, with many of the capabilities of Adobe Photoshop

  GAIM – An instant messaging client


  At this point, there are a few things that you might want to check.


  Is the internet working?*Is your network (if you have one) working?


  Is sound working?


  Are your peripherals working? (Printer, Scanner, Web cam etc.)


  If there are quite a lot of things not working, try a different Linux distribution, as setting up all of it could be a pain. If a couple of things don't work, don't worry, as they will be easy to setup. If you get stuck, you can always ask in the wonderful forums at ubuntuforums.org, or on the #ubuntu IRC channel on irc.freenode.net.


  If you are ready, you can now start to install Ubuntu to your PC. Simply double click on the install button on the desktop.
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  After a brief introduction, the installer will ask for your preferred language, which you can select from the list. Once you have selected your language, click forward.
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  You can now select where you live, so Ubuntu can set the time accordingly, and so Ubuntu can select the closest server to you, to allow you to download updates quicker. You can zoom in on the map, then click your country to select your time zone, or you can select it from a list. Don't worry if the time it states is wrong, as it should automatically change itself later. If it doesn't, you can change it once it is installed.
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  The installer will now ask for your keyboard layout, so that the keys you press will be the ones that appear on the screen. Your keyboard will usually be linked with the country you live in. You can type in the box, to make sure that you have selected the right layout. The main keys you may have problems with are @ and “. If they are switched, you have selected the wrong keyboard type.
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  This is the hard part. You must partition your hard drive so that you can multi-boot with another operating system. This means that you will be able to choose to boot into Ubuntu or your other OS. I did not have a windows partition, so I just chose 'erase entire disk'. You should not do this. You should choose the 'resize partition' option, and adjust the slider to the size you want your new partition to be. If you are not sure, leave it as is.
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  Once you have chosen the size for your new partition, the installer will ask you if you want to import your account files and settings from windows.


  Choose an account if you would like, then type some details below for your new account. As you can see, I didn't have any users to import, so I can just click next and continue.
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  The installer will now ask some personal questions, to save you typing in your name for every program, to save you the effort later. It also asks for a username and password, which you will use to logon later Do Not Lose These! You will be able to set it up so it automatically logs you on, not recommended for safety, later. You can also choose a new computer name, or leave the default. When you are done, click forward.
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  The installer will now display a summary of what it wants to do, so you can go back and change any options if necessary. If you are ready, click install. The installer will show a loading bar, but my install didn't.
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  That's it! The installer will now install Ubuntu for you. You can minimise the installer if you want, and browse the internet or try some other software or games, I recommend you at least wait until the partitioning is done to do this, as you don't want there to be any messing up with that. When the install has finished, you will see the message above


  You can choose to restart or continue using the live CD. If you choose to continue using the live CD, you can press the red power button in the top right. Once you have clicked restart, you will see an unloading bar, then a message to remove your CD, do this, and press enter. Your computer will restart, and you will notice it loads a lot faster this time. Press enter if it gives yo a list of operating systems to boot from, then once it has loaded, you will see the logon screen. Enter your username, press enter, then enter your password and press enter.
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  You will probably (after a few seconds, if you are connected to the internet) see this message:
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  Click the star, then 'Install updates' Most of these will be security updates, or extra features for software. It will ask you for your password, so that it knows that you want to install them, then will download and install them. It will also probably ask for a restart. You now have Ubuntu installed and updated! You should now check that windows still works by pressing the down arrow, and selecting windows on the loading screen. It will probably come up with a message saying it needs to check for errors – this is because it thinks its hard drive has mysteriously shrunk, so its checking nothings wrong. Enjoy Ubuntu!


  

  



  How To

  Directory Structure


  Written by ArsGeek


  One of the most troubling starting points that new Linux users have to get over are where things are kept. The Linux directory structure may seem odd at first, especially to Windows users.

  

  Here's a brief list of the major directories and what they're for.



  
    
      
        	/

        	(forward slash) This is the root directory. The mothership. The home field. The one and only top directory for your whole computer. Everything, and I mean EVERYTHING starts here. When you type '/home' what you're really saying is "start at / and then go the the home directory."
      


      
        	/root

        	this is where the root user lives. The root user is the god of your system. Root can do anything, up to and including removing your entire filesystem. So be careful using root.
      


      
        	/bin

        	Here's where your standard linux utilities (read programs) live -- things like "ls" and "vi" and "more". Generally this directory is included in your path. What this means is that if you type 'ls', /bin is one of the places your shell will look to see if 'ls' means anything.
      


      
        	/etc

        	Here's where the administrative and system configuration stuff lives. For instance, if you have samba installed, and you want to modify the samba configuration files, you'd find them in /etc/samba .
      


      
        	/dev

        	Here's where files that control peripherals live. Talking to a printer? Your computer is doing it from here. Same goes for disk drives, usb devices, and other such stuff.
      


      
        	/home

        	Here's where your data is stored. Config files specific to users, your Desktop folder (which makes your desktop what it is), and any data related to your user. Each user will have their own /home/username folder, with the exception of the root user.
      


      
        	/tmp

        	This is the temporary folder. Think of it as a scratch directory for your Linux system. Files that won't be needed by programs once their used once or twice are put here. Many Linux systems are set to automatically wipe the /tmp folder at certain intervals, so don't put things you want to keep here.
      


      
        	/usr

        	Here's where you'll find extra utilities that don't fit under /bin or /etc. Things like games, printer utilities, and whatnot. /usr is divided into sections like /usr/bin for programs, /usr/share for shared data like sound files or icons, /usr/lib for libraries which cannot be directly run but are essential for running other programs. Your package manager takes care of the things in /usr for you.
      


      
        	

        There are a few other directories you may find as well.

        

      


      
        	/opt

        	Here's where optional stuff is put. Trying out the latest Firefox beta? Install it to /opt where you can delete it without affecting other settings. Programs in here usually live inside a single folder which contains all of their data, libraries, etc.
      


      
        	/usr/local

        	This is where most manually installed (ie. outside of your package manager) software goes. It has the same structure as /usr. It is a good idea to leave /usr to your package manager and put any custom scripts and things into /usr/local, since nothing important normally lives in /usr/local.
      


      
        	/media

        	Some distros use this folder to mount things like usb disks, cd or dvd drives and other filesystems
      

    
  


  

  Now you can consider yourself one step closer to a master Linux user. These directories, while at first a little confusing, will become second nature to you after a bit of use.


  

  



  How To MythTV
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  Written by The Ubuntu MythTV Team


  MythTV gets Feisty!

  The community spoke and our Ubuntu MythTV team listened! With the introduction of the new MythTV packages for Feisty Fawn 7.04, installing and configuring MythTV has never been easier. Many of the annoying installation quirks have been resolved and many suggested improvements have been implemented.

  We think you will agree that the hundreds of hours spent improving, testing and documenting the new Feisty MythTV packages were time well spent!


  New Packaging Changes for MythTV Feisty Fawn


  Here is a summary of the most important improvements directly related to the Feisty packages:


  * MythTV has been updated to a more recent checkout of 0.20-fixes branch to include more recent bufixes and changes

  * Terminal-based commands have been greatly reduced for Desktop installs, making them 99% point-and-click!

  * The mythtv-database will now install a cron job to perform automatic weekly backups of the mythconverg database- keeping your program information and settings safer

  * The user is now notified of MySQL password for the mythtv user and its location in the filesystem

  * To alleviate database access errors, the Packages automatically offer the option to add a user to the mythtv group upon initial startup

  * Mythweb now installs with the correct permissions on all files and directories

  * The mythtv user is added to the cdrom group during installation. DVD Playback will no longer fail because of permissions

  * Mythtv-setup will now automatically prompt to stop the backend before launching and restart it after setup is complete

  * ALSA is now the default sound system on new installations of mythtv-frontend

  * During the start of the init scripts, the QT Authentication warning is now alleviated

  * The HD Home Run QAM support patches from February are now included for better out of the box HD Home Run support.

  * The MySQL root password prompts and mythtv-database installation now assume no root password on the mysql database (as is the case of a new installation)

  o Helps prevent misreading prompts and entering wrong password on mysql install

  o If the password isn't accepted, instructions for reconfiguring the database are provided in both GUI and text form

  

  Metapackages


  * Redefine the existing metapackage, "mythtv" for quick, pain free single desktop installs

  * All backend installs will automatically setup NTP, ensuring that time is always accurate on both master and slave backends

  * Introduce new metapackage- "ubuntu-mythtv-frontend"- for quick standalone frontend installation

  o During the initial startup, the package will detect if the backend was recently installed, and an option to configure it prior to startup is presented to the user

  o Setup automatic GDM login into a mythtv frontend session

  o Parse the ~/.lircrc and launch irexec for the user if it is necessary on a standalone frontend

  o Start a gnome-screensaver in the background for the user

  o Load any customized settings created by nvidia-settings for TV-out or picture enhancement

  o Present a clean background for the user until mythtv starts to load

  * Introduce the new metapackage, "mythtv-backend-master" - for quick standalone master backend installation

  o Automatically configures the database

  o Installs a complete backend

  

  Improved Hardware Support


  Feisty Fawn 7.04 also provides more out-of-the-box functionality for popular tv tuner cards and chipsets. The new kernels included with Feisty have built-in support for the PVR-xxx series of Hauppauge cards, ivtv-based cards and other popular tuners. In many cases, there is no need for further driver installation. Recompiling the IVTV driver is now no longer necessary every time a new kernel is released!

  

  A special page has been created to track the functionality of tuner cards in Feisty, including fixes for instances of partial-functionality. See Tuners and Hardware for more information

  

  Lirc has also been improved for Feisty:


  * Support for both mceusb2 and pvr150 IR transmitters now included in the Ubuntu packages

  * i2c and gpio modules now compile without error on the latest kernels

  * See http://help.ubuntu.com/community/Install_Lirc_Feisty for more information

  

  Installation Guides


  The Official Ubuntu MythTV installation guides have been updated and improved for the new Feisty MythTV packages. These guides are designed specifically for hassle-free installation and configuration, whether you are starting from scratch or adding MythTV to an existing Ubuntu desktop.

  

  Individual guides are included for the installation and configuration for each of the MythTV metapackages. Screenshots accurately depict the installation process step-by-step, from formatting the hard drive (for a new installation) to post-install configuration. Supplementary sections on troubleshooting, video drivers, codecs, plugins and other "What Next" activities have been updated and improved to help you get your system set up and running quickly and as hassle-free as possible.

  

  You can find all of the Official Ubuntu MythTV Guides here http://www.mythtv.org/wiki/Ubuntu_Installation_Guides

  

  Check back next month for new information, including an upcoming Ubuntu/MythTV LiveCD for one-disc installation of an Ubuntu MythTV dedicated system!


  

  



  How To

  Scribus - Part 1


  Written by Ronnie Tucker
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  By the end of this series of Scribus tutorials you'll be able to create a full-fledged publication. Whether it be a colour booklet or a black and white newsletter, the basics are the same. So first we need to learn those basics!

  

  As I write this, the latest version in the Ubuntu repositories is 1.3.3.8 and is named scribus-ng, that is exactly what i'll be using in these tutorials.


  Here we either start a new document or open a previous one. In this first part of the series we'll just be playing around with the most widely used options so we have no need (yet!) to be picky here, just keep the defaults by clicking OK
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  This is our blank page, ready to be edited.
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  The red outline is the very edge of the page. Anything outside that red border will not be printed. The blue lines warn you that should you put anything outside the blue lines (ie: between the blue lines and the red outline) you run the risk of it either being chopped off at the printers or that your printer may not be able to print anything in that area. For now, just think of them as the borders you'd see on a lined A4 writing pad.
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  So lets get started. First thing you need on a page is some nice header text, so click the Insert Text Frame button :

  

  Your pointer will change to a small page with a cross symbol. What we need to do here is hold down the left mouse button and draw a box where we want the text to go. When your happy with the size and shape of the box, release the left mouse button.
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  Thats my box drawn out but where's the text?
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  Double left click inside the text box to add/edit text. Single left click outside the page to stop editing text.
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  Lets say we want to move the text. Easy, just click on the pointer icon at the top of the screen :
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  ... then, with your pointer over the text box, which will change to a grabbing hand icon, hold down the left button and move the mouse! To release the text, release the mouse button.

  

  But our text is a bit small. We need to open the Properties window to gain access to the text box properties. This will let us alter the size and colour of the text. So, go to the Windows menu and click Properties...
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  This is our Properties window. Everything is greyed out since we've not selected anything. From here on in, whenever we select something on our page, tabs will be highlighted in the Properties window to let us know we can edit settings here.
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  Lets enlarge the text size and alter its colour. Single left click on the header text box. You'll see the Properties box spring to life. Click the Text tab in the Properties window.
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  Now we're in business! Lets play around with a few of these options to get you familiar with editing text.

  

  First enlarge the text by repeatedly left clicking on the up arrow beside Font Size (or enter a size value if you want).
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  Next, lets center the text within the box. Click the Align Text Center button.
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  Looking good! Still a bit plain though, lets put a splash of colour in there. Left click beside the paint bucket, scroll up/down through the colours and left click on the colour you like.
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  So we've got a header, we need actual content text now. So drag out another text box but this time make it half the width of the page and quite tall :
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  Rather than spend time typing in filler text (assuming you don't have the actual article yet) we can have Scribus fill in text for us. With the text box still selected go to the Insert menu and click Sample Text.
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  Here we can pick the language of our filler text and number of paragraphs needed. I've just selected Standard Lorem Ipsum (Latin) and ten paragraphs (the default). And click OK.
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  But wait, that's not ten paragraphs! Why was the command ignored? The reason is because the text is actually flowing out the bottom of the text box. If you look closely at the bottom right of the text box, you'll see a small box with an 'X' in it.
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  This symbol tells us that there is not enought space in the box for all the text. We either need to enlarge it or have it flow into another box, otherwise, it will not be visible.

  

  Drag out a new text box on the right half of the page, again, make it tall.
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  This is where the magic happens. Left click once, on the left column of text, this is where the text is to flow from. Now click the "Link Text Frames" button : [image: ] ... and single left click on the right text box
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  Voila! Don't forget to click the Link Text Frames button again to turn it off, otherwise Scribus will think you want to continue linking boxes.

  

  I should mention that the small red squares which show up on the corners of your text boxes are handles, they allow you to resize your text box. Play around with those handles and you'll see your text automatically update itself within the two linked text boxes...
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  Ok, time to save - and export - your work. From the menu, Select File-> Save as:... and enter a name for the document
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  to export the document as an Adobe... Select File->Export from the menu, then chose "Save as pdf"
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  The Preflight Verifier Window should pop up.
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  Don't worry, this is the Preflight Verifier window. It checks your document for possible errors before you package it up as a PDF. In this case it's telling me that there's a text overflow on page 1. Fine, thats my ten paragraphs of Lorem Ipsum that doesn't fit into the two text boxes, no problem. Keep an eye on this Preflight Verifier window, it will save you getting a lot of phonecalls from printers saying that there are things missing, or wrong, in your PDF! So in this case we click Ignore Errors and continue...
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  The Save as PDF window has a ton of options that relate to how the PDF file should look and what should be packaged inside the PDF file. We'll get into all that in a later part of this series for now, give your PDF file a name and click Save.

  

  A window may briefly flash up, thats just Scribus converting the page to PDF, later, we'll see how with several pages it can take a few moments longer to convert to PDF.

  

  So, let's look at out handy-work so far in a pdf viewer :


  [image: ]


  Beautiful! the screenshot shows the document in kpdf (KDE), but since it is pdf it will look the same regardless of what viewer you chose.

  

  I hope you enjoyed the first part of the article, "Using Scribus."

  

  Next month we'll add some images to our little sample page.


  

  



  How To

  Add/Remove Software


  Written by Robert Clipsham


  If you are new to K/Ubuntu, you may be wondering 'How do I install software? Where can I find it? Is it easy?' To put things simply for you: If you have used windows it will be a doddle.

  

  Installing software is easy. From the menu, simply select Applications-> Add/Remove

  

  in Kubuntu, Kmenu-> Add/Remove programs
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  Ubuntu
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    Kubuntu

  


  

  There will then be a message saying 'Checking installed and available applications', and a loading bar. After a few seconds, you will be presented with an easy to use interface, with categories down the side and a list of applications and a description on the right. At the top you will find a search box, which you can use to search for software.
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  Ubuntu
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    Kubuntu

  


  

  Lets say you want to design graphics for a website, and have tried the GIMP, but don't think it has the features you need. Simply open the Add/Remove applications program, or in Kubuntu, Adept Installer, and either choose a category from the left, or use your own search terms, for example, "graphics." You can now sort the programs alphabetically or in Ubuntu by popularity. NOTE: Popularity is the number of times a program has been downloaded. Don't ignore a program just because it has a low rating. It just means it hasn't been downloaded a lot. You can also search within the graphics section for 'design' or 'web', to narrow your results more. Read the description, to find out more about a program.

  

  Once you have found a program you would like (for web graphics I recommend Inkscape), simply click the check box next to a program and click on Apply or Next. The program will ask you if you are sure, then for your administrator password, and automatically download and install it for you.
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  Ubuntu
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    Kubuntu

  


  

  You will get a message telling you where the shortcut is. For Inkscape it will be under Applications> Graphics. That's it. The program has been installed and is ready for use. You will be provided with free program and security updates, without cost!
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  Ubuntu
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    Kubuntu

  


  

  It's just as easy to remove a piece of software, if you don't want it. Simply remove the tick in the checkbox, and click Apply or Next.

  

  There are lots of other ways, other than Add/Remove Applications, to install packages and applications on K/Ubuntu. In Ubuntu you can use Synaptic Package Manager, which gives you control over individual packages. Synaptic can be found under System> Administration. If a program, that you want can't be found under Add/Remove Applications, but it is on the internet, you can get the packages it depends on from synaptic.


  

  



  Review

  GAMPS Geneology


  Written by Adrian Rea
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  GRAMPS - the Genealogical Research and Analysis Management Programming System.

  

  Geneaology is the study of family tree lines, tracing ancestors back as far records legends, or memories can remember. Research skills are the most important, and of those, documenting and backing up your findings is paramount. GRAMPS is a free, open source application that allows you to record your ancestral research findings in a comprehensive and professional interface, then you can produce reports on your data in a number of formats. The GRAMPS project was started by Don Allingham, but has grown to a core set of dedicated developers that are continually expanding, tweaking and testing their product to make it evermore refined. With many open source projects, this development team is not an exclusive group, and anyone can join in to help, learn or test. Their community is based around mailing lists, IRC and a WIKI based website.

  

  This application has been developed originally for Linux and Unix based machines but has been ported to other operating systems including Mac and Windows. For the Ubuntu community, GRAMPS installs and runs on all variants of Ubuntu, though there have been reported display issues with some KDE themes, so if this is a problem, there are remedies available on the website. The program is written in Python, using the GTK/GNOME interface making a database that is generally saved in its .grdb format but is best archived in the larger and slightly slower .xml format.
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  XML allows the database to be transferred more easily across to other computers. The system can cope with large numbers, and has been tested on databases in excess of over 100,000 individuals recorded.

  

  Where to get it – at the time of writing, the GRAMPS version 2.2.6 is available through the Ubuntu Feisty Add/Remove programs, and select to show 'All open source applications'. To install, simply select this version and install. The latest release information can be found on the GRAMPS website. Ubuntu repositories can sometimes lag slightly behind, so make sure you have the latest version! If there is a newer version, you can go to the download section and download the latest package gramps_zzz.deb and gramps-help_zzz.deb, and install with your package manager, normally double-clicking the .deb file is sufficient.
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  Once installed the program can be found in Applications > Office > GRAMPS genealogy system.

  

  In addition to the standard installation, GRAMPS is also available on a LiveCD. This allows usage of the program on any i386 compatible PC directly off the LiveCD without installation required (currently only available for i386, not 64bit or Mac LiveCD, though the program does work on any Ubuntu install). The current version 3.0 includes GRAMPS 2.2.7 within an Ubuntu 7.04 LiveCD and is a great introduction to Ubuntu software. The CD also contains other open source software for the user, including Lifelines and GeneWeb. There is also a link on the desktop that will open up irc and get you directly into the #GRAMPS channel with one double click of the mouse, which is a really useful feature, and one that should be considered for core Ubuntu LiveCDs. One thing to remember is that if you want to save your work while using the livecd, you will need some kind of portable media. A usb stick is ideal. Such detail would be helpful to new users. Of course alongside this is a fully functioning Ubuntu, available for use or install. On a personal note; this was the route that the reviewer became fully interested in Linux and, more specifically, the *buntu distros and community.

  

  Once you have created a database you can get to the interesting part of entering your data. The interface has a pleasing graphical nature, with appropriate icons and pedigree displays. Initially you enter the general individual details of name and gender. Then you need to enter details such as birth, death and occupation etc. each as a separate event within that person's life. This makes data entry a little longer as you need to open a new event for each item of data. However, in understanding the system, this makes the data more qualitative. Other genealogical software may offer more entry on the initial individual's data page, but the GRAMPS system encourages methodical data entry backed up with source information. The events are structured to make data entry easier. For example the initial event shown is for Birth. If this has already been entered the next logical field is Death and this comes up automatically within the form.
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  As you add more and more data, so the additional views within GRAMPS become more useful. You can navigate and catalogue your data under the headings of People, Relationships, Family View, Pedigree, Events, Sources, Places, Media and Repositories. I have personally found that the Relationships view one of the easiest ways to navigate a database with more than 50 individuals.

  

  As suggested earlier, documenting research findings are key to proving the validity of the genealogical data. The 'source' is the reference for each item of data, that gives it credibility. There can be many items of data within a source and GRAMPS has a 'scratchpad' that allows you to copy source reference between individuals within your tree. To your individual, you can add media, such as photographs, sound and movie clips that can be display or linked to from within the database.
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  Once you have your database, it is good to make a hard-copy version to share, archive and refer to. GRAMPS can produce a fantastic array of output, including books that collate many aspects of your data and presents them in a single collection to your own specification. These reports can be made in a variety of formats including Open Document format, HTML, even SVG depending on the type of report. Charts, time lines and ancestral reports can all be made, and there is an active development in producing further report formats. In addition to this, a database can be output to for a website structure that can be uploaded to a server and displayed for all to see and navigate.

  

  SUMMARY

  

  PROS

  Strong database management with good community support and development multi-format export/output including XML, GEDcom and HTML

  

  CONS

  extra clicks for basic data entry

  grdb database not easily portable

  

  full circle issue #2 will have an exclusive interview with the creator of GRAMPS


  

  



  Interview

  Zach Tibbitts - Deluge Bittorrent


  Written by Spyro


  So Zach, what's your background with computers and programming?

  

  Well, my mother is a software engineer for IBM, so I've been exposed to computers from a very early age. My first experience with programming was in the seventh grade, when I got a programmable TI-83+ calculator and began to program in BASIC. After that, I took a class in Visual Basic, and then C++ during two summers, and then an AP Java class in high school.

  

  At this point, I'm a Junior at the University of Louisville's Speed School of Engineering, majoring in Computer Science and Computer Engineering.

  

  Is Deluge the first piece of software you have worked on?

  

  It's the first really big piece of software that I've worked on. I've done several little things in the past, but this has been my most involved project to date.

  

  Well, I'm not the only one working on it. The other original developer, Alon Zakai (a.k.a. Kripkenstein), helped a lot, and really deserves more credit than he seems to get. Also, we used the libtorrent library, so we didn't have to do a lot of the torrenting process ourselves.

  

  How did you learn to program and how long did it take?

  

  Mostly just from experience. While I have taken a few classes, most everything I know about computers comes from just trying and learning, including programming. Deluge was actually the first time I had used Python before, and I just learned as I went along. As I said earlier, I first started programming in the seventh grade, so that was about 8 years ago.

  

  What made you decide to create a bittorrent client?

  

  The lack of a good, lightweight, GTK+ client. Deluge (then gTorrent) started as a discussion on Ubuntuforums.org about the need of a good GTK+ bittorrent client. That discussion is where I first met Kripkenstein, and we began to brainstorm ideas to create the client.

  

  What advantages does Deluge have over other linux bittorrent clients?

  

  Not a ton, at the moment. It is a nice, lightweight client, and offers a decent feature set. At the moment, it supports DHT, resuming partial downloads, and downloading multiple torrents in the same window. While other linux clients, such as Azureus, offer more features than Deluge does currently, they typically do so at the cost of increased system resource usage. Not to knock Azureus, but Deluge is intended to get the job done and just download the file without all the extra bells and whistles.

  

  How would you rate the success of Deluge, and where would you like to see it going?

  

  I think it's going great, so far. I've been outright amazed at the level of attention Deluge has received. People often find me online to thank me for starting it, and often tell me that they had never found a Linux client they liked before Deluge.

  

  Obviously, I'd like to see Deluge go far, and I've got some plans for the future. My top priority is bugfixes and other stability issues, after that, I can get to the actual new features.

  

  Are there any specific features you would like to develop further?

  

  As far as new features, the new release of Libtorrent supports Peer Exchange, so we'll probably make use of that. Also, the development branch of Libtorrent has encryption support as well, so look for that in the future. I'm also wanting to incorporate UPnP support, though I've heard that Libtorrent is working on that as well, and finally, I'd like to work on a WebUI for the client.

  

  'Andrew M' asked if there will be a KDE version?

  

  I'm not going to say no outright, but there probably won't be. As it is, Deluge will run just fine under KDE assuming you have the necessary libraries installed, but it's unlikely that we'll develop a QT interface for it. If you really want a native KDE client, you'd probably be best off using KTorrent

  

  Do you have a preferred Linux Distro you work in?

  

  Ubuntu, for the most part.

  

  How difficult is it working with the bittorrent format?

  

  Well, we don't really work with bittorrent directly, all of that is done via libtorrent, which in turn is done using Kripkenstein's wrapper class, so I haven't really worked with it directly very much.

  

  Other clients seem to be adding custom features these days, does that create too much of a competitive streak? Do client programmers feel like they have to create a killer 'new feature'?

  

  Yes and no. First off, I don't plan on creating any Deluge-specific "killer features," but rather on making a good implementation of the existing bittorrent features. The problem with creating your own features is that other clients won't have them. An example of this is Azureus's implementation of DHT, which can only connect to other Azureus clients.

  

  I'm not concerned about creating the "Killer feature." Instead, I just want to create a simple, yet full featured client that incorporates the best features that the bittorrent protocol offers.

  

  Is a WebUI (similar to utorrent's) planned? And will there be a way to select/deselect all files in the files list? Clicking one at a time is a pain.

  

  Yes, I know that's a pain, and I plan on fixing that when I get a chance.

  

  As for the WebUI, I mentioned that earlier, and yes, I'd like to do one. I just played with uTorrent's WebUI earlier today, and I was fairly impressed with it, and would like to implement something similar in Deluge.

  

  Do your family use Linux or is it hard to promote it in a currently Windows dominated environment?

  

  Well, I use linux, and my mother dual-boots for work. My father uses Windows, but doesn't have trouble if he has to use one of my linux boxes to check his email, etc.

  

  I've had several people ask me to "teach" them linux, especially recently, now that Vista has been released. Most of them don't want to migrate to Vista and are looking for an alternative.

  

  What programs and development systems do you use?

  

  Well, really all I use is a basic text editor and a compiler, at least when it comes to Python. Really, my development environment will change depending on what language I'm working in, i.e. Eclipse for Java, Monodevelop for C#, and either a simple text editor or Eclipse/CDT for C/C++ clients.

  

  And finally; what advice would you give to a budding programmer?

  

  Start by writing small programs that do something neat. Keep it interesting, because you need to be able to have fun while you're developing. The best resources available to you are the source code of other programs, and other developers online. Look at the source for other programs to see how they work, and how you can apply similar strategies in your own projects. Finally, find that "killer program" that's missing and write it. For me, that program was a GTK bittorrent client, but you should find something that you think Linux (or whatever OS you use) is missing. You don't need a ton of experience to start work on a project, but as you work on it, your skills will improve, and actually programming on a real project will develop your skills well past what simple programming exercises can do

  

  full circle would like to take this opportunity to thank Zach for taking the time to sit under the spotlight and be grilled!

  

  Next months interviewee will be none other than Colin Watson, Installer Team Leader, Ubuntu Community Council Member and Line Manager for half the distro team!

  

  Please email your questions for Colin to: questions@fullcirclemagazine.org


  

  



  My Story

  Researching Ubuntu


  Written by Magnus Wahlberg


  At my school they have something they call ”forsknings profil” it’s Swedish and translates to something like “Scientific/research profile”. That basically means that the students get to test what it’s like to do research at university level. Obviously the scales of the research projects are much smaller. Anyway if you apply for “forsknings profil” and get selected (like me), you get to borrow a laptop during the time you study and do your research.

  

  So I received my laptop, a HP nx8220 I booted it up and not too surprisingly it had Windows XP preinstalled. So I did what I had to do, install Linux. Although it wasn’t exactly straight forward… I started out with a nice open hat, a fedora to be more precise. And let me tell you it wasn’t the most yummy experience I’ve had. The screen resolution refused to go higher then 1024*768, no wireless and it seemed virtually impossible to update the darn system. I took the hat and threw it out the window, literally five fedora cds flew out of my house in the order: cd 2, 4, 1, 3, and 5 (just random by the way). The next distro served to the laptop was a green German lizard, the Chameleon Suse. It too had serious problems with the graphics and as it seemed at the time problems with pretty much everything I tried. So I made a smoothie of the Suse DVD and went out looking for a distro that would just work.

  

  And guess what I found it, a strangely named Linux flavor; Ubuntu. After downloading and burning the one cd (!). I slammed it into my laptop and fifteen minutes later it was done. About an hour later I was convinced that heaven is coffee colored. I mean seriously it just worked, everything was up and running out of the box (or rather out of the cdr…). The graphics, network, sound, updates I mean hell even the custom buttons at the top of the keyboard worked (in fact better than in Windows!). Unfortunately my adventures with Ubuntu managed to get me failed in the class that had first brought me the laptop to install it on. But that doesn’t really matter because I have a new friend, a brown friend that by the way now can turn itself into a cube, burn up and wobble around (thanks to my buddy Beryl). Ubuntu – Linux for human beings? Nah more like: Linux for people who like when their computers just work, and the color brown.


  Letters


  In Praise of Unsung Heroes

  

  I am, I must confess, not quite a newbie. I've been using Ubuntu now for the best part of a year.

  

  You would then think I would know what I am doing, but alas not, being thoroughly institutionalised in Windows, it has been up hill all the way. So I come to the Heroes of my title, through all my trials and tribulations, not to mention head banging frustration, they came to my aid, helpful, encouraging and prompting.

  

  Who are they? Well, I will tell you. They are the strangers who come to my rescue - the readers and more importantly, the responders in the Ubuntu forums. So many times over the last year, when all has been lost and with no hope insight, I have turned to the forums to see if anyone else has broken apt, lost their internet connection or can't play mp3s etc. Without fail, I am not alone. So far I have not had to post a question but I have read the dozens of answers given to others with the same problems as me. The community of Ubuntu has never ceased to amaze me with their help, patience and lack of negative attitude to newbies, who often have very little understanding of what they are doing. It can't be easy trying to help some one who knows little or nothing of command line and, in my case, gets cold sweats when opening a terminal.

  

  Slowly, very slowly, as it happens, with the aid of the forums, I have overcome so many hurdles. With each upgrade I have gained more confidence - which is how I broke apt. This time I thought, this time, I will have to do a fresh install - but no, just when I was about to give in, help came again from the forums.

  

  This is why they are my heroes and I for one will sing their praises.

  

  Michael House

  

  Editor replies -

  

  I totally agree. Had it not been for friendly places like UbuntuForums this magazine would never have come to fruition!

  

  Only by utilising the massive (and i mean massive!) userbase at UbuntuForums was I able to reach out to other volunteers who also wanted to help create an Ubuntu magazine.

  

  I often wonder what the state of Linux would be without Ubuntu and Ubuntu Forums. Imagine you were using another distro, where could you turn for help? What other forum is that helpful and has so many users? In my opinion, very few forums have both criteria...


  

  



  Q & A


  
    	I need java. Is java on Automatix2?


    	Sun Java JRE is available through the Ubuntu repositoriies.You can install it by doing: sudo aptitude install sun-java6-jre

    Or from your Add/Remove Programs application. See our tutorial on p.26 of this issue for how to add/remove applications.

    We can not recommend Automatix due to potential upgrade/update issues.


    	



    	I was wondering if there was a Linux program that will allow me to compress a DVD movie that I ripped.


    	When you make video smaller, that's called encoding. It's not the same as compression, and I think that encoding is what you want to do.

    CLI:

    - Handbrake

    - mencoder

    GUI:

    - dvd95 (GNOME)

    - k9copy (KDE)

    - DVD Shrink (wine)

    http://ubuntuforums.org/showthread.php?t=439588


    	



    	Ubuntu seems to have a cool enough clean look to it, but is there a way to customize it to look as/more visually attractive as/than Vista?


    	Compiz is pre-installed on Ubuntu, just go to System>Preferences>Desktop effects, then click enable. If you want a more customisable look, you can use beryl (www.beryl-project.org) and use themes from www.gnome-look.org or www.kde-look.org.

    http://ubuntuforums.org/showthread.php?t=439230


    	

    


  


  MY DESKTOP


  Written by Victor Doman
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  I have Ubuntu Feisty Fawn installed and heavily modified. Right now it's a blend of Xfce and GNOME, the gtk theme is Murrina Gliouche and the metacity theme is called Simplebox Custom. You can get the murrina engine from here. The icon theme was collected by me and is probably the biggest collection of tango icons around, but unfortunately, i can't distribute it because i don't know all the licenses the icons are under, they're not all GPL. However, the next best thing is the Tango Generator. It has icons for other apps too, not just GNOME in general.

  

  Here is the wallpaper i was using.

  


  My PC


  Written by Ronnie Tucker


  [image: ]


  This is where it all happens folks! Full Circle is made right on this here machine. Looks snazzy with the lights but it's only :

  

  AMD Athlon XP 2600+

  512mb RAM

  nVidia GeForce4 MX (128mb RAM)

  Netgear wireless modem/router

  Bluetooth Adaptor

  hba1 = 110gb

  hdb1 = 55gb

  CD-RW & DVD-RW

  Two 12" striplights; one blue, one yellow


  [image: ]


  So nothing too big and fancy. It was a dual-boot between Windows XP and Kubuntu Dapper but it's now Kubuntu Feisty only. I'm now completely Windows free! Whee!

  

  I also have a Compaq nx9005 laptop which is even less impressive and has Xubuntu installed on it.


  

  



  Top5 Linux Games


  Written by Jeremy LaCroix


  Frozen Bubble


  [image: ]


  Homepage: http://www.frozen-bubble.org/

  

  There's nothing like penguins to brighten up your day. Frozen Bubble, a puzzler similar to SNK's “ Puzzle Bobble” back in the arcade scene, remains to this day one of the most popular Linux games of all time. There's a good reason, too, because it's also the most addictive. The goal is to break all of the colored orbs hanging from the ceiling. You do so by shooting more orbs at them, trying to match the colors. If the orbs touch the bottom, you lose. It sounds simple, but can be very challenging. Ubuntu 7.04 includes Frozen Bubble 2 available for download, which includes some nice new features, such as extended network play, and chain reactions.

  


  


  Battle for Wesnoth


  [image: ]


  Homepage: http://www.wesnoth.org/

  

  Battle for Wesnoth is a real-time strategy game that can be played online against other players or against the CPU. There are even fan-made campaigns you can download right from Ubuntu's repositories, extending the game even further. In most campaigns the goal is to defeat your enemies leader. Take control of villages to earn money, and summon troops to aide you. When you have a formidable army, position your troops in as strategic a way as possible to ensure victory.

  


  


  Chromium
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  Homepage: http://www.reptilelabour.com/software/chromium/

  

  Stunning graphics, kicking music, and shooting action. What more could you possibly want? Chromium has some easy controls too, as everything is controlled by your mouse. Chromium, even in its easiest difficulty level, is a very challenging game. Its been said in a sense that the goal of Chromium is to relieve anger from a stressful day, not necessarily to win. Losing has definitely never been so much fun!

  


  


  Planet Penguin Racer


  [image: ]


  Homepage: http://www.planetpenguinracer.com

  

  Planet Penguin Racer is a fully 3D racing game, is a blast to play and looks absolutely gorgeous. Its based on Tux Racer, however this version adds much more content such as new courses and features. Please note that hardware acceleration for graphics is recommended for smooth game play.

  


  


  Neverball


  [image: ]


  Homepage: http://icculus.org/neverball/

  

  The interesting thing here is that your keyboard or mouse controls the platform the ball is on, instead of the ball itself. When you tilt the platform, the ball will respond and roll around, and you must collect enough coins without falling off the platform or running out of time. The graphics are full 3D and as such, hardware acceleration is required for this game to run properly.


  

  



  ﻿FULL CIRCLE NEEDS YOU!


  A magazine isn't a magazine without articles and Full Circle is no exception. We need your Opinions, Desktops and Stories. We also need Reviews (games, apps & hardware), How-To articles (on any K/X/Ubuntu subject) and any questions, or suggestions, you may have.


  We are always looking for new articles to include in Full Circle. For article guidelines, ideas, and for issue translation, please see our wiki:



  http://wiki.ubuntu.com/UbuntuMagazine


  Please email your articles to:

  articles@fullcirclemagazine.org


  If you would like to submit news, email it to:

  news@fullcirclemagazine.org


  Send your comments or Linux experiences to:

  letters@fullcirclemagazine.org


  Hardware/software reviews should be sent to:

  reviews@fullcirclemagazine.org


  Questions for Q&A should go to:

  questions@fullcirclemagazine.org


  Desktop screens should be emailed to:

  misc@fullcirclemagazine.org


  ... or you can visit our forum via:

  misc@fullcirclemagazine.org


  Full Circle Team:


  Editor - Ronnie Tucker -

  ronnie@fullcirclemagazine.org


  Webmaster - Rob Kerfia -

  admin@fullcirclemagazine.org


  Comms Mgr - Robert Clipsham -

  mrmonday@fullcirclemagazine.org


  Podcast - Robin Catling -

  podcast@fullcirclemagazine.org


  Editing & Proofreading:


  Mike Kennedy

  Lucas Westermann

  Gord Campbell


  Our thanks go out to Canonical, the many translation teams around the world and to Thorsten Wilms for the current Full Circle logo.
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